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About WindSim 

Micrositing 

WindSim is a modern Wind Farm Design Tool (WFDT). WindSim is used to optimize the 

wind farm energy production while at the same time keeping the turbine loads within 

acceptable limits. This is achieved by calculating numerical wind fields over a digitalized 

terrain. In the wind energy sector this is called micrositing. 

 

By coupling the numerically calculated wind speeds and wind directions against available 

site-specific climate conditions the optimal position for each turbine can be found. Climate 

conditions are most frequently given by on-site measurements but could alternatively be 

derived from meteorological models. WindSim can interface with both of these types of 

datasets. 

 

The loads on a wind turbine are influenced by wind field characteristics such as; wind shear, 

inflow angle, and turbulence. Since the wind field modelling is 3D all of these characteristics 

are calculated and checked to be within acceptable limits for a given turbine type. 

 

The optimization of the energy production and the minimization of the loads could be 

conflicting processes. The location yielding maximum energy production for a wind turbine 

could also yield too high loads, and often a compromise must be found: a location with the 

highest possible energy production still with acceptable loads. Micrositing is an iterative 

process where various turbine locations and types have to be inspected. 

Modular Approach 

WindSim uses a modular approach with six modules to complete the steps within micrositing. 

 

 

Figure 1 - WindSim is a modular based Wind Farm Design Tool (WFDT) 
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A full micrositing will require execution of all six modules. The modules must be executed in 

the right order as there are dependencies between the modules. However, depending on the 

purpose of the project, it is not always necessary to run all the modules. 

WindSim Modules 

• Terrain 

Establish the numerical model based on height and roughness data. 

• Wind Fields 

Calculation of the numerical wind fields. 

• Objects 

Place and process wind turbines and climatology data. 

• Results 

Analyse the numerical wind fields. 

• Wind Resources 

Couple the numerical wind fields with climatology data by statistical means to provide 

the wind resource map. 

• Energy 

Couple the numerical wind fields with climatology data by statistical means to provide 

the Annual Energy Production (AEP); including wake losses. Determine the wind 

characteristics used for turbine loading. 

 

In addition to the modules there are stand-alone Tools for data preparation and data post-

processing. In particular, Tools are used for the import and preparation of terrain and 

climatology data. WindSim also works with Add-on Modules including the Remote Sensing 

Correction Tool (RSCT) and Park Optimizer. 

About the Technology 

Computational Fluid Dynamics (CFD) is used to perform the wind field simulations in 

WindSim. CFD is a numerical method for solving the fundamental equations of fluid flow. 

CFD has become a very useful method within many industries. Accurate flow simulations are 

required within the automotive industry, oil and gas, and of course within the aerospace 

industry. In these industries CFD has become the standard method for flow calculations. 

 

The fundamental behaviour of fluid flow is described by the Navier-Stokes equations. The 

Navier-Stokes equations are non-linear partial differential equations known to be unstable 

and difficult to solve. Therefore simplified methods, where the troublesome non-linear terms 

have been linearized have become popular within the wind energy sector. However, the 

severe penalty is the reduced accuracy in the results. 
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The differences between the traditional so called 

linear method and the CFD method could be 

illustrated by looking at speed-up over a ridge. The 

speed-up increases with increasing inclination 

angles until the flow separates, as seen in the upper 

part of Figure 2. 

 

This behaviour is captured by a CFD method. Even 

for smaller inclination angles, when the flow does not 

separate there is a significant difference in predicted 

speed-up between the linear and the CFD methods. 

 

For an inclination angle above 20 degrees (Case C) 

the flow separates. The recirculation acts as an 

extension of the terrain, the ridge becomes more like 

a plateau and the speed-up is reduced. 

 

The Navier-Stokes equation is time averaged 

introducing terms for the speed fluctuations. A 

turbulence model is required to close the equation 

set of the so-called Reynolds Averaged Navier-

Stokes equation (RANS). The RANS equations 

are discretized in a computational domain and 

integrated with a finite-volume procedure. 

 

There are various solvers and solver strategies 

implemented in the software. Turbulence is taken 

into account using various types of two equation 

models like the k- model. 

 

We invite you to learn more about the Bolund Experiment. The Bolund experiment is a field 

campaign that provides datasets for validating numerical models of flow in complex terrain 

and was the basis for a unique blind test comparison of flow models. The CFD methods—

including WindSim—showed the lowest errors among the various methods used. Find out 

more about The Bolund Experiment (windsim.com). 

Figure 2 - Upstream speed-up, (Speed hill 

top/speed inlet). Average inclination angle 

(degrees) A) 5.7 B) 11.3 C) 21.8 - Linear 

model (light grey) CFD model (dark grey). 
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https://windsim.com/library/the-bolund-experiment/
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WindSim Evaluation versus the WindSim Commercial Version 

WindSim Evaluation (EV) contains all the features of the commercial version but is intended 

for evaluation use. WindSim EV can be downloaded for free. The only restriction of WindSim 

EV is the maximum number of cells used to discretize the computational domain. The total 

maximum numbers of cells are 50 000, and there are 10 layers of cells vertically. The limit on 

the number of cells; as will be shown in the following paragraphs, have two effects: 

 

• It smoothes the given height and roughness data 

• It introduces significant discretization errors 

 

The results obtained with WindSim EV are therefore not intended for commercial work. 

However, the user will be able to explore all the features of the software with the evaluation 

version, and also appreciate the power of the commercial version. 

Installation 

Download WindSim EV or the commercial version from Download (windsim.com) and run the 

installation file. Before installation read the instructions on the download page concerning 

minimum PC requirements and concerning which software that needs to be pre-installed on 

your computer. 

 

Guidance on the installation process and in particular the license access for the commercial 

version is described here: 

https://windsim.com/library/User%20Guides/230124_WindSim_Installation_WS12.pdf 

 

WindSim is by default installed on C:\Program Files\WindSim, while the project folder 

where WindSim projects are saved is located in the folder 

C:\Users\User_name\Documents\WindSim Project. You may change these default 

settings during the installation. After installation while running WindSim, projects could be 

saved at arbitrary locations. 

 

Once WindSim is installed it can be run from the shortcut added on the desktop or from the 

list of programs in the Start Menu of Windows. 

  

https://windsim.com/downloads/
https://windsim.com/library/User%20Guides/230124_WindSim_Installation_WS12.pdf
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Explanation of Controls & Nomenclature 

The program consists of the following components: 

• Title bar 

• Menu bar 

• Module selector, with inherent progress monitoring 

• Information pages, displaying descriptions, reports and 3D models 

• Start and Task list 

• Properties with brief descriptions 

• Processing output 

• Progress monitoring 

 

 

Figure 3 – WindSim Controls & Nomenclature 

Title Bar 

The title bar consists of the following items:  

• The WindSim icon logo 

• Name of the program with including version number 

• Name of the current project 

• Name of the current layout 

 

 

Figure 4 - Title bar. 
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Menu Bar 

The menu bar consists of the following items: 

• File 

• Layouts 

• Modules 

• 3D Visualization  

• Tools 

• Export 

• Settings 

• Help 

 

 

Figure 5 - Menu bar. 

File 

Under the File drop-down menu, you will find all the controls needed for File management: 

• New 

o Project…    Create a new project 

o Express project…   Swap to WindSim Express 

o Project copy…   Create a new copy of the current project 

o Layout copy…   Create a new copy of the layout(1) for the 

     current project  

• Open 

o Project…    Open a project  

o Layout    Open a layout(1)  belonging to the current 

     project  

• Recent Projects     List of the recently used projects 

• Remove 

o Project     Remove the current project  

o Layout     Remove the current layout belonging to 

     the current project  
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• Print…      Print the currently displayed page 

• Print preview…    Preview the currently displayed page 

       before  printing 

• Save       Save the current project 

• Revert to saved    Reset the properties to the state before 

       last module execution 

• Open project folder    Opens location of the project folder 

• Open report folder    Opens location of the report folder 

• Open program folder     Opens location of the program folder  

• Properties     Open a window with summarized main 

       information on the current project 

• Exit       Exit WindSim 

(1) Layout: when a project has more than one layout, the Terrain and Wind Fields will remain the same. Layout copy enables you 

to test different wind farm configurations using the same Terrain and Wind Fields data. 

Layouts 

Under the Layouts drop-down menu, the following commands are available: 

• Create copy…     Create a new layout as a copy of the 

       current one 

• List of loaded layouts     tick off the layout you want to activate 

• Terrain texture file 

o Open…    Load a .bmp or .rgb texture file to paste 

     over the terrain 

o List of loaded textures  Tick off the texture file you want to 

     activate 

Modules 

Under the Modules drop-down menu, the user can choose which module to run. The 

functionality of each module is described in more depth later in this document. The present 

drop-down menu is equivalent to the Module Selector: 

• Terrain 

• Wind Fields 

• Objects 

• Results 
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• Wind Resources 

• Energy 

3D Visualization 

In this module the user can select several 3D Visualization items:  

• Generate 3D wind visualization file (.vtf)… Generate a wind visualization file  

• Open 3D wind visualization file (.vtf)…  Open an existing wind visualization file 

• Download 3D samples …   Download .vtf files from the WindSim  

       website. 

• Download sky textures …   Download sky background examples 

       from the WindSim website. 

 

The .vtf files can be opened with GLview PRO the application for post-processing provided 

with the full installation of WindSim. 

Tools 

• View terrain model (*.gws)…   View the terrain model in a text editor 

• Import terrain model (*.gws)…  Import a terrain model to WindSim 

• Convert terrain model…   Convert terrain data from .map format to 

       the WindSim format .gws 

• Terrain Editor…    Launch the Terrain Editor application 

• Find forest parameters   Launch Excel sheets for the calculation  

of forest parameters 

• Advanced conversion : 

o Convert terrain model (CMD) Convert terrain data from other formats 

     to the WindSim terrain format, *.gws 

o Convert climatology data (CMD) Convert climatology data from other  

     formats to the WindSim format .wws  

• Meso-Microscale Coupling Console… Import results from a meteorological 

       model 

• View climatology data (*.wws)…  View the climatology file in a text editor 

• Convert climatology data…   Convert climatology data from the .tab 

       format to the WindSim format .wws 

• Create power curve (*.pws)…   Create the power curve file of the  

       considered wind turbines if they are not 

       present in the WindSim database 
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• Import objects (*.ows)…   Import objects into WindSim from an 

       *.ows file 

• Export object (*.ows)…   Export objects in the current layout to 

       an .ows file 

 

• Losses and Uncertainties...   Calculation of losses and uncertainties 

• Flow Model Validator…   Validation of simulated vertical profiles

      against measured profiles 

• MCP…      Launches the plugin to do MCP 

      (Measure-Corelate-Predict) 

• Reanalysis Data Downloader…  Launches the plug-in to download 

       MERRA mesoscale date 

• Queue…     Launches the plug-in to define a queue 

       of wind field simulations 

• Park Optimizer …    Launch the Add-on Module WS Park 

       Optimizer 

• Remote Sensing Correction Tool...  Launch the Add-on Module WS Remote 

       Sensing Correction Tool, used to correct 

       LIDAR data based on WindSim results 

Export 

 

• Export climatology data (*.tab)…  Export a climatology file to the .tab  

       format 

• Export object (*.ows)…   Export objects in the current layout to 

       an .ows file 

• Export to Google Earth(.kml)…  Export report maps to Google Earth 

• Create Word report...    Generate a report of your project in .doc 

       format 

• Export HTML report...    Generate a report of your project in  

       HTML format 

• Export vertical profiles…   Extract vertical profiles of chosen scalar 

       at turbine and/or climatology positions 

• Export WindPRO flowres file…  Exports the results from the Wind Fields  

module to a WindPRO readable format 

• Export Openwind WRB file…   Exports the results from the Wind Fields  

module to a Openwind readable format 
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• Export Lookup Tables    Creates tables for wind power forecasts 

Settings 

In the Settings section you will find: 

• Show key…     Open the Sentinel Admin Control Center 

• Advanced Settings…    Choose the output file type asci or binary 

• Change language    Change the current language 

• Limits…     Click to see the computational limits of 

      WindSim models 

Help 

In the Help section you will find: 

• About WindSim…    Version and License information 

• Release Notes    Links to web-based version of the Release 

      Notes RSS-enabled 

• Manuals     Access to the manuals: Getting Started, 

     MCP, Reanalysis data downloader 

Module Selector 

The Module Selector consists of the following modules: 

• Terrain 

• Wind Fields 

• Objects 

• Results 

• Wind Resources 

• Energy 

 

 

Figure 6 - Module selector with the Terrain module activated. 

 

Click on a module button to activate it. 

 

Your progress with WindSim’s modular approach is always visible. Once selected, a Module 

button can have one of three states: 

• Modules with a green check have been run successfully. 

• Modules highlighted with animated circular arrows are running. 

• Modules with a grey cross have not been run or needs to be updated. 
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NOTE: There are important dependencies among the modules. 

 

You must first run the Terrain module in order to establish the computational model to 

successively generate the wind database. When the Terrain module has a green check, you 

can run the next module, the Wind Fields module. 

 

In the Wind Fields module the wind database is generated. This database contains detailed 

information about the wind field in the computational model established in the Terrain 

module. If the user now goes back to the Terrain module and change any of the parameters, 

the Terrain module will become red. It needs to be re-run to be updated, and the same 

procedure must be done with the Wind Fields module. It does no longer contain a wind 

database that is compatible with the terrain model the user re-defined in the Terrain module. 

Once the user has calculated the terrain model and the wind database the Terrain and Wind 

Fields modules will have green checks, then you may start working with the other modules. 

 

The Objects module will place and process climatology data and place wind turbines. They 

are commonly called “objects”. Both climatology and wind turbine objects must be specified 

in the Objects module in order to process all the remaining modules. 

 

The wind data are visualized in the Results module. Both the Terrain and Wind Field 

modules must be correctly run before you can run Results. 

 

The wind measurements contained in the climatology files are used to weight the wind 

database. This is done in order to get realistic data about how the wind is influenced by the 

terrain in the Wind Resources module.  

 

The wind turbine’s locations and power curves loaded in the Objects module are combined 

with wind measurements in the Energy module, to compute a complete estimation of the 

energy production. 

 

The best way to get a good feel for these dependencies is to start working with WindSim. 

 

Please refer to the tutorial project Hundhammerfjellet described later in this document for 

further guidance. 
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Information Pages 

There are Description and Report pages in all WindSim modules, and in most modules 

results can be displayed in a 3D model. By clicking on either of the links you are able to 

toggle between the corresponding pages. The active link is coloured blue. In the Objects 

module there is one additional link to activate the Park layout. Whenever the information 

pages contain sub-pages the toggles Back and Forward are used for browsing. 

 

 

Figure 7 - Information pages. 

Description Pages 

The description pages describe the purpose of a module. It explains which consideration you 

need to make in order to successfully run the module. The Description pages also give a 

detailed explanation of the Properties, which is the module input. The Description page 

header displays the module name, the WindSim version number, and the date when the 

pages were last updated. 

 

 

Figure 8- Description page header. 

Report Pages 

The report pages contain the results from the corresponding module. The Report page 

header contains information about the project. There is information about the License, 

Customer, Project, Layout, WindSim version number, and a timestamp when the report was 

generated. 

 

 

Figure 9 - Report page header. 

3D 

The report pages contain figures of various datasets, in the module Terrain elevation and 

roughness can be displayed, in the module Results multiple datasets of various flow 

variables can be displayed. By pressing the button 3D the corresponding dataset displayed 
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in the report page will be opened in the 3D viewer GLview. If there is no available dataset on 

a given report page, then pressing the button 3D have no effect. 

Start and Task list 

Each module is run by clicking on the Start button. The Task List appears above it is showing 

if the module is ready to be started or if a previous dependent module has to be started first. 

 

Figure 10 - Start button and Task list. 

Properties 

In the Properties panel located on the right-hand side of the screen, all the settings for a 

given project are specified. Each module has its own set of properties. Explanations of the 

properties are found on the Description pages. You can click on the property to insert and 

type the desired values. You can also use the arrow keys to move up and down through a list 

of options provided to make a selection. Whenever you need to specify more than one value 

for a property, the semicolons syntax is used to separate the values. Press the Enter key 

when ready to enter a new value or click somewhere outside the current input field in order to 

set a new value. 

 

The frame below the Properties panel shortcut information about the selected property is 

given. 

 

NOTE: More detailed information about each property is found in the Description page of the 

current module. 



 

© 2022 WindSim | DUPLICATION OF THIS DOCUMENT IS PROHIBITED WITHOUT PRIOR PERMISSION 

14 Explanation of Controls & Nomenclature 

 

Figure 3 - Properties for the Terrain module including property information of the selected 

property (roughness height) in the lower frame. 

Processing Output 

In this frame you will see the output result concerning the module which is currently running 

or just finished. This result may contain information describing if the module has been run 

correctly. Otherwise, it will display errors, warnings, or additional information. 

 

 

Figure 4 - Processing output frame. 

Module - Progress 

 

Figure 13 – The WindSim Module Selector displays your progress through the modules. 
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Your progress with WindSim’s modular approach is always visible. Once selected, a Module 

button can have one of three states: 

• Modules with a green check have been run successfully. 

• Modules highlighted with animated circular arrows are running. 

• Modules with a grey cross have not been run or needs to be updated. 
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Tutorial Project: Hundhammer 

In this tutorial project we look at the site of Hundhammerfjellet, or simply Hundhammer, 

located on the coast of Norway. The tutorial will guide you through all six modules of 

WindSim, supplying you with the required input. 

 

NOTE: All inputs have suggested default values, which for most cases would be the 

recommended value to use. Whenever a default input value has been modified it is 

highlighted with an orange overlay. 

 

Open WindSim and start a new project by choosing: 

 File > New > Project... 

The New Project window is opened: 

 

 

Figure 14 - New Project window. 

 

Set your project location, which is the folder where your project will be stored, by browsing 

your hard drive, push the button  or use the default path, 

(C:\Users\User_name\Documents\WindSim Projects), give a project name, leave the Layout 

name as Layout 1, and finally enter the name of your customer. If no GWS file is specified, 

then the grid.gws with the terrain from Hundhammer will be automatically copied from the 

WindSim installation area. In this tutorial, this field is kept empty to load the default terrain 
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data. Elevation and Roughness data are read from the .gws file and imported in the new 

WindSim project. Click OK in order to create the project. 

Terrain 

The first step within micrositing is the generation of a 3D model in the Terrain module. This 

involves choosing the horizontal and vertical extension of the volume to simulate. This 

volume, which we will call the computational domain, is then discretized into a system of 

hexahedral cells called a grid or mesh. The computational domain is built based on the digital 

terrain in *.gws format containing information about elevation and roughness. 

 

WindSim can be run either by using the default settings in Properties or by specifying your 

own settings. 

 

NOTE: If you specify a non-default property value, then it is shown in bold type. There are a 

few exceptions to this rule. Properties associated with terrain extensions are always shown in 

bold type as they are project specific, a given default value equal for all projects can’t be set. 

 

In WindSim Evaluation (EV), the maximum number of cells in the vertical direction has been 

set to 10, while the total number of cells in all three directions has been limited to maximum 

50 000. In the commercial version of WindSim, the maximum number of cells would typically 

be limited by the available computer resources. Models with millions of cells can be 

simulated on PCs with a 64-bit operating system. The restrictive limitation in WindSim EV on 

the number of cells used for the computational model means that the results will not have the 

accuracy required for a proper micrositing thus WindSim EV it is not intended for commercial 

work. 

 

Run the Terrain module by clicking on the Start button with the below default settings: 
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Figure 5 - Property settings for the Terrain module with default values for the tutorial project 

Hundhammer. 

 

Upon successful completion, the Module Selector of the Terrain module will have a green 

check and the Description pages will automatically be switched to the Report pages. Some of 

the content in the report is presented below. 
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Figure 16 - Plot from Terrain module report; 2D Field: Elevation. 

 

Click on the black arrows above the plots in the Report pages to visualize various 2D field 

data: 

• Elevation 

• Roughness height (z0) with both linear and logarithmic scale 

• Inclination angle (deg)  

• Second order derivative of the elevation  

• Delta elevation. 

The delta elevation variable gets a non-zero value only when the smoothing option is applied to the model. 

 

Click on 3D Model and the black arrows to visualize: 

• Grid (xy) 

• Grid (z)  

• Open area 
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Grid (xy) and Grid (z) contain information about the grid spacing and number of cells used for 

the discretization in horizontal and vertical directions. 

  

The Open area data is a useful tool to understand if too much blockage has been introduced 

in the generation of the 3D model. A Wind Field simulation can be viewed as a numerical 

wind tunnel test; too much blockage would produce unphysical and therefore unacceptable 

speed-ups. The ratio between minimum and maximum open area is used in the automatic 

generation of the proper height of the 3D model, see the Description pages for details. 

 

When you click on 3D at the upper right of each plot; a 3D model in the visualization tool 

GLview is opened. The 3D visualization option is available for all the sections 2D Fields, 3D 

Model, and Extension. The 3D visualization option is also available in the other modules of 

WindSim. 

There is a separate section in this document that further explores GLview. For now, we only 

explain the basic operations of movement:   

• Translation with left mouse button 

• Rotation with right mouse button 

• Zoom with mouse wheel or both mouse buttons simultaneously 

 

Click on Extension to visualize the horizontal extension of the generated 3D model which is 

marked with a grey frame over an elevation contour map: 
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Figure 17 - Plot from Terrain module report; Extension 

 

The contour map for the Extension is based on the original resolution of the .gws file, thus on 

the maximum possible resolution and not on the 3D model which is coarser than the original 

digital terrain data. The difference in resolution is particularly clear when comparing the two 

plots under 2D Field: Elevation and Extension. 

 

NOTE: If you want to reduce the extension of the model, that is resetting the X- and Y-range 

of the properties given in Figure 15, then it is convenient to use the visualization tool GLview. 

You open GLview by clicking “3D” while Extension is displayed in the report, see figure 18. 

 

Next you should identify the coordinates of the lower left and upper right corner of the new 

reduced model you will establish. In GLview coordinates can be displayed for any cell in the 

grid by selecting the cell with the cursor while pressing down the “Ctrl” button. Note that 

when then “Ctrl” button is held down the cursor changes from and arrow to a plus sign as an 

indication that the selection mode is active. A cell is selected by pressing the left mouse 

button. Pressing the right mouse button allows for selection of properties, chose “Display 
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Polygon info…” and the output would be similar to Figure 18. In Figure 18 a cell with 

coordinates (5500,3000) have been selected. Hence adding 5500 meters to the X-min value 

of the X-range and 3000 meters to the Y-min of the Y-range will establish a model with the 

selected point as the lower left corner. 

 

 

Figure 18 – Displaying cell (polygon) properties in GLview 

The same procedure can be used to select a new upper right corner of your model. For more 

information about the coordinate systems used in WindSim, see the description pages for the 

Terrain module. 

 

In order to produce a higher resolution grid, which means smaller discretization errors in the 

area of interest where the wind farm has to be constructed, a new extraction of a smaller 

area will be done. 

Assign a new extension to the terrain model in the Properties panel by new X-range and Y-

range. Define a refinement area to design an even denser grid in the area of interest, where 

the wind farm has to be located: 
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Figure 19 - Property settings for the Terrain module, reduced area with refinement. 

 

In this way you have cropped from the original .gws file an area only covering the ridge of 

Hundhammer, where the wind farm will be located. The borders of the computational domain 

are still quite far from the area of interest in order to avoid too heavy boundary effects. 

 

NOTE: The X- and Y-range of the refinement area is by default set to be in the centre of the 

model. Whenever a resetting of the X- and Y-range of the total modelled area is done, also a 

resetting of the refinement area should be done to keep the refinement area in the centre. A 

simple way to achieve this is to set the property Refinement area to “No refinement” and then 

reselect it to “Refinement area”. At this stage the X- and Y-range of the Refinement area will 

be based on the newly set X- and Y-range of the total model and you will automatically 

obtain the values given in Figure 19. 

 

Click “Start” on the right-hand side of your screen to run the Terrain module again. 

 

Click on Terrain > Report > Extension to get the Figure 20 and Figure 21 in the Report frame, 

which shows the extension of the new 3D model compared to the original gws terrain data.  

 

NOTE: When refinement is applied, the horizontal resolution varies. Its minimum and 

maximum values are available in the Report > 3D Model and Grid (xy). 
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Figure 20 - The digital terrain model, marked as a box, with given extensions is extracted from 

grid.gws. 

 

Click on Terrain > Report > 3D Model, and then select Grid (xy) using the black arrows to 

obtain the report on the horizontal discretization of the generated 3D Model shown in Figure 

21. 
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Figure 21 - Terrain > Report > 3D Model: Grid (xy) 

 

Click on Terrain > Report > 3D Model and then select Grid (z) using the black arrows to obtain 

the report on the vertical discretization of the generated 3D Model, shown in Figure 22. 
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Figure 22 - Terrain > Report > 3D Model: Grid (z). 

 

Click on Terrain > Report > 3D Model. Then select Open area by using the black arrows to 

obtain what is shown in Figure 23. The criteria named Open area account for the ratio of 

minimum and maximum area of the intersections of the computational domain with vertical 

planes south-north and west-east directed. The wind field simulations can be seen as 

numerical wind tunnel “runs”. So, it is important to reduce the blockage effect which produces 

unphysical speed-up. 

 

NOTE: The ideal height of the 3D model is computed automatically in order to keep this ratio 

above an acceptable value, see Description for details. 
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Figure 23 - Terrain > Report > 3D Model: Open area. 

Wind Fields 

Once the generation of the 3D model has been completed in the Terrain module, the CFD 

simulations of the wind fields can start. The wind fields are determined by solving the 

Reynolds Averaged Navier-Stokes equations (RANS). The standard k- model is one option 

for turbulence closure. The RANS equations are discretized and integrated with a finite-

volume method. Starting with the initial conditions, which are guessed estimates, the solution 

is progressively resolved by iteration until a converged solution is achieved. 

 

There are four possible ways to solve the RANS equations in WindSim: 

• GCV; a General Collocated Velocity method. Very robust. Always delivers a 

converged solution. 

• Parallel GCV; a parallel solver of GCV splitting a numerical model in sub-models and 

use separate CPUs on each sub-model. 

• GCV+HYPRE; HYPRE is a library of high-performance preconditioners and solvers, 

with BoomerAMG. This uses algebraic multigrid (AMG) algorithm for the linear 

equation solver for the GCV algorithm. The new solver setup shows a better 

convergence behaviour for big models run with parallel option. 
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• Parallel GCV+HYPRE; same as above including parallelisation, that is splitting a 

numerical model in sub-models and use separate CPUs on each sub-model. 

For more information concerning the solver you can look at the “Description” in Wind Fields 

module. 

 

Select the Wind Fields module and run the module with default settings. A window will pop 

up to let you follow the development of the wind field during the iterative solution procedure 

The Field value monitored by default is the Speed scalar XYZ at ground level, that is at the 

first Z level, which is the 2D field displayed in Figure 24. If several sectors are solved 

simultaneously on different processors, then one window will open for each sector being 

solved. 

 

 

Figure 24 - One window will pop up for each simultaneous sector being run, by default the 

Field value monitored is the Speed scalar XYZ. 
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By default, the software monitors the magnitude of the velocity vector at the ground level (at 

the centre of the ground adjacent cells). If the simulations have reached a converged 

solution, you should not be able to see any further change in this plot. 

 

In the Report pages you can check whether the modelling has been carried out correctly, by 

inspecting the graphs of the Spot and Residual values for all the solved variables. This is 

shown in Figure 25 and Figure 26. 

 

 

Figure 25 - Wind Fields > Report > Spot Values. 

 

 

Figure 26 - Wind Fields > Report > Residual Values. 

 

The report pages for the Spot and Residual values are completed with three tables regarding 

setting and status of the performed calculations. 
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In the Table 1 on the following page there is a summary of Boundary and Initial Conditions 

adopted for the simulations; Table 2 reports the Calculation parameters and the current 

status of the simulations while the Table 3 provides further information about Physical 

models and output for the wind field simulations. The parameters summarized in these tables 

are all explained in the description pages of the Wind Fields module. 

 

 

Figure 27 - Wind Fields report 

 

In the Wind Fields > Report > Field Value menu, it is also possible to see an animation of 

the development of the chosen variable during the iterative process. In well converged 

simulations, the calculated variables should not change any further as the iterative process 

reaches the end. A screenshot of the monitored variable is shown in Figure 28. 
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Figure 28 - Wind Fields > Report > Field Value. 

Objects 

The Objects module is used to: 

• Place turbines in the wind farm 

• Process climatologies 

• Place transferred climatologies 

 

Geometrical objects can also be placed within the 3D terrain model for visualization 

purposes. At the actual Hundhammer site there are 17 turbines and 2 climatologies. This 

layout is already established. It can be read by using the command: 

Tools > Import objects (.ows)...  

Load the file: 

C:\Program Files\WindSim\WindSim 12.0.0\Data\Objects\Hundhammer.ows 

 

Note that the name "Program Files" might vary according to which operating system you run 

on your computer 

 

17 wind turbines will be added to the park layout. The following window message will pop-up 

if the import is successful: 
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Figure 29 - Successful import of objects from an .ows file. 

 

An alternative to the procedure described is to introduce new objects interactively in the Park 

Layout of the Objects module using the Toolbox on the right-hand side: 

 

 

Figure 30 - Toolbox for interactive manipulation of objects. 

 

with the following tools: 

   Select mode 

  Add turbine mode 

  Add climatology from file 

  Add transferred climatology mode 

  Remove selected object 
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  Remove all 

 

With the Park Layout it is possible to add, drag and drop wind turbines in a graphical window. 

This helps the user to design the park layout and make modifications to it. After adding a 

turbine, it could be moved interactively. Change the position of an object by first activating 

the "Select mode" in the Toolbox. Next, select an object by the clicking the left mouse button, 

the objects are moved with the mouse while pressing the Shift button. 

 

The user still needs to load the climatology files (.wws or .tws), before running the module. 

Load a climatology using the "Add climatology from file" from the Toolbox. Two climatologies 

have been prepared for the site at Hundhammer namely: 0150-Tommerhol-30m_1year.wws 

and 0801-Hundhammer-30m_1year.wws located under the folder: C:\Program 

Files\WindSim\WindSim 12.0.0\Data\Objects\Climatology. Both sets of data are for 

anemometers at 30 meters height and referred to the same measuring period of 1 year. By 

using the "Add climatology from file" these climatologies are copied into the project folder 

structure. 

 

Remark that climatology objects can’t be moved, their position is given in the .wws or .tws 

files. The only way to change the location for a climatology object is to change the 

coordinates in the files. 

 

The Objects module is now ready to run, click on the Start button. The layout of the wind 

farm can be visualized by selecting the Report > Object representation menu. The report for 

the Objects module will appear as in Figure 31 and Figure 32. The main features of the 

climatologies and turbines within the wind farm are listed in the tables 1 and 2 of the report. 

 

Further information on climatologies and turbines are given if the user clicks on the links 

(blue bold type) in the tables. An animation is available which is activated by Report > 

Animation and 3D to open GLview Pro. An animation is also available directly in the Park 

layout. 



 

© 2022 WindSim | DUPLICATION OF THIS DOCUMENT IS PROHIBITED WITHOUT PRIOR PERMISSION 

34 Tutorial Project: Hundhammer 

 

Figure 31 - Objects > Report > Object representation. Wind. 

 

 

Figure 32 - Objects > Report > Object representation continued. 
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A photo or texture can be pasted on the terrain to provide a more realistic view of the wind 

farm area. Load the file hundhammerfjellet.bmp by opening Layouts > Terrain texture file 

> Open …. The file is located under the folder:  C:\Program Files\WindSim\WindSim 

12.0.0\Data\Texture. Run the object module again in order to apply the texture. Activation of 

Texture in the Objects module report gives a plot with the photo draped over the terrain as 

seen in Figure 33. 

 

 

Figure 33 - Objects > Report > Object representation with Texture. 

 
Click on 3D objects and open this graphic in GLview by clicking the 3D button. This 

allows various perspective views of the wind farm. At this stage fly-troughs could be 

generated, check out the 3D Samples at the WindSim web site. 
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Figure 64 - Perspective view of the Hundhammer wind farm. 

Noise calculations 

Noise calculations are performed in the Objects module. First, select a wind turbine or a 

climatology and then select Noise calculation>Based on broadband at the “Objects frame”, 

as shown in Figure 35, in order to carry out a noise analysis, which can be output at any 

height, for any wind direction and for any wind speed. The default settings produce a noise 

map in 2 meters' height, for a northern wind of 5 m/s. The wind direction and wind speed are 

by default defined to be the conditions at the Hundhammer climatology. 

 

 

Figure 35 - Example Properties for the CFD noise calculations in the Objects Module 

 

Background noise level is set to 0 db so that only the noise contribution from the wind 

turbines is estimated. Local standards or project requirements may require the background 
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noise to be included. The attenuation coefficient represents the industry standard for 

broadband noise. More experienced users might wish to adjust this constant to account for 

site specific atmospheric conditions and/or to account for an octave band analysis. 

Run the Object module again by clicking the Start button. 

 

A new set of reports is generated with a separate noise map found under Report > Object 

representation > Noise. The map represents the noise pressure level in dB for all locations 

in the project. 

 

 

Figure 36 - Noise Calculation report 

Results 

In the Results module you can extract 2D horizontal planes with variables stored in the wind 

database. The 2D plane is a so-called “terrain plane”, that is a plane following the terrain but 

at a given height above the terrain. The “terrain planes” can be extracted from ground level 

up to the "Height of reduced wind database" as specified in the Wind Fields module. 

 

In the below “CRT” is used as an abbreviation for “Cartesian”, hence “UCRT”, “VCRT” and 

“WCRT” means the velocity components along the X-axis (West-East), Y-axis (South-North) 

and Z-axis (Vertical). The following variables and derived variables are available in the wind 

database: 
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Speed scalar X  Wind speed scalar in the West-East direction, UCRT [m/s] 

Speed scalar Y  Wind speed scalar in the South-North direction, VCRT [m/s] 

Speed scalar Z  Wind speed scalar in the vertical direction, WCRT [m/s] 

Speed scalar XY  Wind speed scalar in 2D, √(𝑈𝐶𝑅𝑇2 + 𝑉𝐶𝑅𝑇2)  [m/s] 

Speed scalar XYZ  Wind speed scalar in 3D, √(𝑈𝐶𝑅𝑇2 + 𝑉𝐶𝑅𝑇2 + 𝑊𝐶𝑅𝑇2) [m/s] 

Velocity vector XY  Wind speed vector in the horizontal plane, (UCRT,VCRT,0) 

Velocity vector XYZ  Wind speed vector in 3D space, (UCRT,VCRT,WCRT) 

Direction scalar  Wind direction in the horizontal plane [deg] 

Direction scalar relative Wind direction in the horizontal plane relative to the incoming 

wind direction [deg] 

Turbulent kinetic energy Turbulent kinetic energy, 𝐾𝐸  [m2/s2] 

Turbulent intensity  Turbulent intensity assuming isotropic turbulence,  

    100 ∗ √
4

3
∗𝐾𝐸

√(𝑈𝐶𝑅𝑇2+𝑉𝐶𝑅𝑇2)
 [%] 

Turbulent dissipation rate Turbulent dissipation rate, 𝐸𝑃 [m2/s3] 

Pressure   Relative pressure minus hydrostatic term [Pa], the relative 

    pressure has a value equal to zero at the outlet of the domain 

Inflow angle  Angle between the wind vector and the horizontal plane [deg] 

Wind shear exponent Exponent alpha of the equation 
𝑠𝑝𝑒𝑒𝑑1

𝑠𝑝𝑒𝑒𝑑2
= (

ℎ𝑒𝑖𝑔ℎ𝑡1

ℎ𝑒𝑖𝑔ℎ𝑡2
)

𝑎𝑙𝑝ℎ𝑎
 [-] 

 

As an example the Velocity vector XYZ and the Turbulent kinetic energy at 50 m height is 

extracted. Remember to press New every time a new variable should be activated: 

 

1. Click New at the “Properties” window. 

2. Choose “Velocity vector XYZ” at the “Normalisation variable” menu. 

3. Click New at the “Properties” window once more. 

4. Choose “Turbulent kinetic energy” at the “Normalisation variable” menu. 
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Figure 37 - Properties panel, Results module, extraction of Velocity vectors 

 

Figure 38 - Properties panel, Results module, extraction of Turbulent kinetic energy 

 

NOTE: The height for the extracted results has been set to the default value of 50 m above 

ground level. Typical heights of interest are the turbine hub height and the height of the wind 

measurements. 

 

NOTE: That the default legend setting of 0;0 sets the minimum and maximum values found 

in each extracted dataset as legend limit. 

 

NOTE: The default number of Sector angles is the same as the set sectors in the module 

Wind Fields. 

 

Run the module by clicking the Start button. The report will display plots of the “Velocity 

vector XYZ” and “Turbulent kinetic energy” for all 12 sectors as shown in Figure 39 and 

Figure 40. In total the report will consist of 24 plots, that is: 2 variables x 12 sectors x 1 height  

= 24 plots. There is a limit of 200 plots that could be generated during one run. Re-run the 

module if the 200-plot limit impose a restriction on your exploration of the various datasets. 
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Figure 39 - Results > Report.  Wind velocity 3D (m/s) for sector 0° at 50 m a.g.l. 

 

 

Figure 40 - Results > Report. Turbulent Kinetic energy (m2/s2) for sector 0° at 50 m a.g.l. 
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If a figure does reveal sufficient details, then further details can be inspected in the 3D viewer 

by clicking the information page button 3D. The wind field displayed in Figure 39 indicates a 

recirculation zone in the mid part of the model, more specifically on the lee side of the ridge 

when wind is coming in from north. Below in Figure 41, the wind field is inspected in detail by 

zooming in on the recirculation in the 3D viewer. Notice that the recirculation zone is the 

reason for the high level of turbulent kinetic energy at the same location, seen in Figure 40. 

 

 

Figure 41 – Inspection of the recirculation zone for sector 0° at 50 m a.g.l. 

 

It is important to note that the Results module is a tool for visualization of the wind field 

database. To observe how the wind fields are affected by shifting terrain elevation and 

roughness. In the module Results the wind fields are not calibrated against climatology data, 

as such the resulting wind fields reflect the boundary conditions set in the module Wind 

Fields. In the next two modules Wind Resources and Energy, then the wind database will be 

calibrated against climatology data. 

Wind Resources 

The Wind Resources module is used to create wind resource maps at chosen heights. 

 

NOTE: The Results, Wind Resources and Energy modules are independent from each other, 

it is not necessary to run them sequentially. If, for example, you are only interested in the 
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energy production, you can just run the Energy module and it is not needed to run Results 

and Wind Resources first. 

 

At least one visible climatology must exist in the current layout before running the Wind 

Resource module. All sectors defined in a given climatology must exist in the wind database. 

The wind resource map is established by weighting the wind database against the 

climatology. If several climatology objects are available, the wind resource map will be 

weighted against all of them. This is done by an inverse distance interpolation of the 

climatology objects. A wind resource map is also established for each climatology separately.  

 

Run the Wind Resources module to create a wind resource map for the Hundhammer project 

at 50- and 80-meters height with the properties given in Figure 42. 

 

 

Figure 42 - Properties panel of the Wind Resources module. 
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Figure 43 - The wind resource map which is the 2D mean wind speed at 50 m a.g.l. weighted 

against all climatologies. 

Wake Modelling 

If the user is concerned about wake losses in the wind farm (also known as wind park effect), 

one of the 3 wake models can be activated. These wake models can be used both in the 

module Wind Resources, and Energy. A complete description of the models is provided in 

the description page of the Wind Resources module. 
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Figure 44 – Activation of a wake model in the Properties panel of the Wind Resources module. 

 

Activate “Wake Model 1” and re-run the module. The Report now contains new pages, 

displaying the reduced wind speed or the so-called wake deficit, see Figure 45. 

 

 

Figure 45 - Wake deficit at hub height, wake model 1. 
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Energy 

The Annual Energy Production (AEP) is the most important parameter to be estimated in 

most micrositing projects. For a given wind condition, the available power is proportional to 

the third cube of the wind speed. This means that an uncertainty in wind prediction is largely 

increased when computing the available power; so high-quality wind modelling is particularly 

appreciated within micrositing. 

 

Run the Energy module with the default settings except for the activation of a wake model as 

seen in Figure 46. 

 

 

Figure 46 - Properties panel for the Energy module. 

 

The Energy report gives several tables summarizing the AEP including wake losses on the 

wind farm level, see Figure 47, and on a per turbine level. For each climatology object, two 

AEPs are given in the report. 

 

• The first one is obtained from the frequency table of the climatology files. 

• The second is obtained by Weibull fitting the frequency table. 

 

An estimate of the AEP is given per climatology and for all available climatologies, using the 

same interpolation technique as in the module Wind Resources. 
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Figure 47 - Energy report on the wind farm level including wake losses. For more information on a per 

turbine level click on any number in the column “AEP with wake losses”. 

 

There is a 1.67% difference in the estimated AEP when using the two different climatologies, 

((140.8233 – 138.4683)/140.8233)*100 = 1.67%. Ideally there should be no difference in the 

estimated AEPs, but since both the wind measurements and the numerical simulations 

contains errors there will always be discrepancies. 

 

One of the errors associated with numerical simulations stems from the discrete nature of the 

numerical model. In particular if the numerical model has a too low resolution the 

discretization error can be significant. Ideally the numerical model should have a sufficiently 

high resolution, such that a further increase of the resolution would not change the numerical 

results. In this case the numerical model is said to be grid independent. See next section 

where grid independency with respect to AEP is investigated for the Hundhammer project. 
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A Grid Sensitivity Study 

In this section we investigate the effect of discretization errors on the numerical results. We 

use the AEP for the whole wind farm as a metric for the numerical results, comparing the 

AEP obtained for five different numerical models with the number of cells given in Figure 48. 

 

N Nx Ny Nz 

4 370 23 19 10 

24 320 38 32 20 

90 280 74 61 20 

375 000 150 125 20 

750 480 212 177 20 

Figure 48 - Number of cells in models used for grid independency tests 

 

Ideally a so-called grid independent solution is obtained, giving the minimum discretization 

error, when a further increase in the number of cells doesn’t change the AEP. 

 

 

Figure 49 - Report panel for the Energy module, Hundhammer project (~5 000 cells). 
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Figure 50 - Report panel for the Energy module, Hundhammer project (~25 000 cells). 

 

 

Figure 51 - Report panel for the Energy module, Hundhammer project (~100 000 cells). 

 

 

Figure 52 - Report panel for the Energy module, Hundhammer project (~400 000 cells). 

 

 

Figure 53 - Report panel for the Energy module, Hundhammer project (~800 000 cells) 
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The AEP calculated with the five different models is summarized in Figure 53. Important 

discretization errors are present for the two models with ~5000 and ~25000 cells. 

Considering a grid independency reached with a model of 800 000 cells, a model comprising 

just 5 000 cells gave errors of 20 % for one of the climatology data. The model of size 100 

000 cells provided a good estimation of the AEP, the errors could be considered within 3%; 

considering a grid independency reached with 800 000 cells. 

 

It´s important to stress that the characteristics of a grid which is leading to grid independency 

is its resolution. So, for wider areas, a higher number of cells are required to minimize the 

discretization errors. 

 

 

Figure 54 - AEP for the two climatologies against number of cells used in the 3D models. 
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Configure Particle Traces in GLview Pro 

Generation of the Wind Visualization File 

How to generate a 3D wind visualization file (.vtf) in the menu”3D Visualization” is shown 

below: 

 

 

 

Figure 55 - The .vtf file is generated from the 3D Visualization menu on the toolbar 

 

The generated .vtf file must contain the 3D velocity vector, which is the vector field used to 

establish the particle traces. 

1. Click 3D Visualization > Generate 3D wind visualisation file (.vtf). A DOS pop-

up window will appear.2. Type “l” to choose from the list of sectors. 

3. Choose the sector 000 by simply pressing “000”. 

4. Type “1” to transfer the default variables to the .vtf file. 

5. Open the 3D Visualization file by clicking 3D Visualisation>Open 3D wind 

visualization file (.vtf)… and then selecting the 000.vtf file. 

Activate the VELOCITY_3D as vector by pressing the “Apply” button as shown in Figure 56. 

The max and min values of the chosen scalar and vector fields will appear in the blue info 

window in the lower right corner: 
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Figure 56 - Set Vector to VELOCITY_3D and hit Apply in the dialogue box to the bottom left in the 

screen above 

Setting the Attributes 

Zoom in towards the terrain of the model, as shown below. Rotate the model by using the 

right mouse button. Then set the attributes of each part in the “Change Part Attributes…” 

window found under “Model”  

 

Then the grid has to bet set invisible first by choosing “grid” and then unselecting the attribute 

“Visible”. Finish the process by pressing the “Apply” button. 
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Figure 57 - Configure the view to display the relevant parts 

 

In the Change Part Attributes the default setting of all parts which is “Visible” and “Outline 

mesh” could be reset. Selecting all parts is done by clicking on the first part, while holding 

down the shift key clicking on the last part. 

 

While all parts are selected, uncheck the “outline mesh” box and check “smooth shading” to 

give a better visual appearance (see Figure 57). 
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Figure 58- Perfecting the visualization to your projects specific requirements is easy in WindSim! 

Creating the Particle Traces 

Before calculating particle traces you need to define the start positions for the traces. Each 

trace represents the path of an artificial particle without mass following the wind field in a 

passive manner. In order to get a good representation of the wind field it is convenient to 

specify many traces. This is done by specifying the start positions within a box, with a given 

number of start positions in   x, y, and z direction. To open the window “Particle Traces” click 

Vector > Particle Tracing… (see Figure 59).The dimension of the box will be model 

dependent. In the model below the box is positioned towards the North border as the wind 

field with incoming wind from North has been loaded (000.vtf).  

 

The coordinates (X1,Y1,Z1) and (X2,Y2,Z2) represent the front left bottom point  and the far 

upper right point respectively. In order to specify the dimensions of the box, you need to set 

these coordinates and then click “Apply” (see Figure 60). 
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Figure 59 - Open the dialogue box from the Vector menu on the toolbar 

 

 

Figure 60 - Replicate the settings above to achieve the same particle traces 

 

Under the folder “Options” the user can set the direction for the calculation of the traces. In 

the given case the calculation is only done forward, as the box with starting point is put near 

the inlet border therefore the traces will pass through most of the model.  
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In some cases, the default method for integrating the paths, the Euler method, will fail. If the 

traces do not follow the terrain, but appears like straight lines pointing towards the sky, then it 

is recommended to switch to the linear integration method. 

 

 

Figure 61 - Set the direction of your particle traces 

Animating the Traces 

From the window “Particle Trace” the folder “Startpoint” should be chosen. Then by choosing 

the “Display Setup” button in the upper right corner the window “Particle Trace Display 

Setup” will open.  

 

The setting for animating the particles is set in this window. 

 

• Check the box “Animate” to unlock the animation options. 

• Check the box “Incremental trace” 

• Uncheck the box “Complete trace” 

• Press the “Apply” button. 

 

Try to animate using line (worm) by check the box “Tail”. Play with the settings and see what 

works for your model. 
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Figure 62 - The user has full control over the simulation parameters to design an animation to 

suit any project requirements 

Textures 

The final touch for your presentations is obtained by adding textures. Textures could be 

added to the different parts. For example, adding a satellite photo or a scanned map to the 

DTM (Digital Terrain Model) would make it easier to recognize locations in the model. The 

only purpose of the cylinder surrounding the model is to add a “sky texture”. 

 

A texture is added to a part using the “Change Part Attributes” window introduced above. 

Select the part and then click the button “Texture…”. In the “Texture Settings For Part(s)” 

window, a picture must first be loaded and then this picture must be pasted over the part 

from a given direction, defined by the “Plane”. The picture is stretched over the part if the box 

“Clamp” is checked. Otherwise, a tile pattern is generated. 
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Figure 63- Adding a sky texture greatly enhances the quality of the visualization 

Save and Share 

When you are satisfied with the setting, you can save all the settings to a new .vtf file in the 

menu “File” – “Export to File” – “VTF File…”. Send us your .vtf file and we will publish it at 

windsim.com under: 3D Visualizations (windsim.com) 
 

 

Figure 64 - Just one example of the infinite customizability of WindSim visualization 

https://windsim.com/library/3d-visualizations/
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Configure Isosurfaces in GLview Pro 

Generation of the Wind Visualization File 

Generate a 3D wind visualization file (.vtf) in the menu ”3D Visualization” following the same 

procedure as in paragraph “Configure Particle traces in GLview Pro”. 

 

 

Figure 65 - Locate the menu show above 

 

The generated .vtf file must contain the 3D velocity vector, which is the vector field used to 

establish the particle traces. Moreover, the .vtf has to contain the scalar variable that has to 

be plotted as isosurface. 

Open 3D Visualization file 

Open the 3D wind visualization file (.vtf) in the menu 3D Visualization. Activate SPEED_2D 

as Scalar by pressing the button “Apply”, then the min and max values of the chosen scalar 

fields will appear in the blue info window in the lower right corner (see Figure 66).  
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Figure 66 - Set the Scalar to SPEED_2D and hit Apply 

 

Setting the Attributes 

Zoom in towards the box and rotate the model by using the mouse buttons. Then set the 

attributes of each of the parts in the “Change Part Attributes” window found under “Model” – 

“Change Part Attributes…”. First the grid has to bet set transparent by selecting the grid and 

check the attribute “Transparent” then press the button “Apply” (see Figures 67 and 68); then 

the transparency level has to be put to the maximum value (0.0), click on the Material button 

to set the transparency to 0.0 as shown in Figure 69, then click on OK and Apply to confirm. 
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Figure 67 - Open the Change Part Attributes dialogue box 

 

 

Figure 68 - Replicate the selections made above 

 

 

Figure 69 - Open the Material Properties box by clicking the Material... button 

Creating the Isosurfaces 

Select the “Isosurface...” option under the Scalar menu (see Figure 70). Select the value of 

the loaded scalar that you want to display and press Apply, as shown in Figure 71. Rotate 

and zoom with the mouse to obtain a good view of the flow field. 
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Figure 70 - Open the Isosurface dialogue box from the Scalar menu 

 

 

Figure 71 - The above value generates a nice plot for the Hundhammer project 

 

 

Figure 72 - The Isosurface is now displayed relative to the terrain to visualize the flow in the wind farm 

Textures - Save and Share 

For adding textures and sharing data with others see the procedures described in the above 

section “Configure Isosurfaces in GLview Pro”. 
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Figure 73 - A texture adds a nice touch to the graphics for use in presentation and reports! 


